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Welcome to MailBell

MAILBELL -- AN EMAIL CHECKING TOOL FOR WINDOWS

(C) EmTec Innovative Software, 2000 - 2003

What is MailBell
MailBell is a utility that lives in your system tray and periodically checks email on POP3, IMAP4, MAPI and 
Hotmail/MSN accounts. It can check multiple accounts and works on lans and permanent internet connections as well
as with dial-up networking (where it automatically detects when you go online).    

When new mail arrives the program can automatically start your mail reader, play a sound and/or display an 
unobstrusive notification window from which yon can start your mail reader if you like (by clicking with your right 
mouse button on it). 

Additionally MailBell can detect undesired email based on it's senders or certain words and lets you delete it without 
the need to download it into your email program.    You will also be able to manually delete email with    large 
attachments without download, e.g. if someone sent you a large movie file or sound clip. Good places to start 
learning more about this program are: 

o Using the program/Common tasks 

o Configuring the program 

o Tips/Questions/Problems 

o Ordering MailBell 

o Support and Bug-Reports 

o Author-Contact 

 



Step by Step Instructions to Manage and Remove Spam

This text is available directly from Help menu (First Steps).    

Check inbox for new mail and handle spam
To manually run a mail check, click on the account in the upper part of the window and select "Check new 
mail".    Based on the account's settings (Accounts, Edit) MailBell will run checks periodically (e.g. every 10 
mintues). 

Preview an account's message list
You can select an account in the program window and then click on the message list button.    This will make 
the message list appear in the lower part of the window.    From there you can preview messages, check their 
spam status or delete them using the right mouse button menu on the message (right click a message to show 
a menu with these functions). 

When spam is found
Based on the initial configuration, MailBell analyzes your email when checking the account and assigns a 
certain amount of points to each message (the more points the more likely the message is spam).    Depending 
on the result, the program will preselect the message for manual deletion in the message list window (see 
above) or even delete it and save a copy in the trash list for later review (and final deletion). 

Fine tune the spam detection and spam handling
To fine tune the spam detection and change the handling (e.g. make it more agressive or more tolerant or to 
add more information to help telling spam from regular mail), please select Tools, Basic Spam Options. The 
help texts for the individual configuration dialogs provide background information on how to use these settings 
most effectively. 

New email notification
There are several ways how the program can tell you about new mail. You can have a popup window (which 
can be closed by a left click in the window and with will start your email program on a right click), you can have 
a message box that will ask you if you want to start the email program and you can play a sound file for new 
mail.    Any combination of these is possible and can be configured in the Email section of the program's 
options. 

Changing the program or email configuration
The general appearance and working of the program is configured in Tools, Program Options. 
Some settings (like mail server or update frequency) refer to individual mail accounts rather than to the 
program at large. If you want to account specific settings, click an account in the main window and Account, 
Edit. 

How to add/change mail accounts
After the configuration wizard, you will see one entry in the main window, which refers to your account. 
You can monitor an arbitrary amount of inboxes and each can have a different configuration (mail check 
frequency, colors for the popup window, etc.). To manage (add, delete, modify) accounts, use the Accounts 
menu. 

Mail types
You can have different types of notification depending on keywords in the mail's from, to and subject fields and 
in the first few lines of the mail's text.    E.g. you can play a different sound for mail from important persons or 
suppress notification for spam or mail of low interest.    Mail types are configured in the program's options. 

Working with the minimized program
If you minimize MailBell, the program will hide itself behind an icon in the system tray.    When mail is available, 
the icon will show the number of available messages. A double click will, depending on how your configured the
program, either bring up the MailBell window or your email program.    A right click will bring up a menu and a 
single left click will perform an action depending on your MailBell options' settings (e.g. start to write a new mail
or check accounts for mail). 

Starting your mail program
There are several ways to start your mail program from MailBell
* double click a mail entry in the main window
* double click the symbol when the program is hidden



* right click the new mail notification popup window
* click the leftmost icon in the toolbar
* select Start Mail Program from the File menu

 



Command line options

When starting the program you can provide the following parameters in the command line: 

/CHECK
Immediately after starting, MailBell will check all accounts. 

/WORKDIR
Will load the configuration files (accounts.inf, mailtypes.inf, mailbell.ini) from the specified directory, e.g. 
/WORKDIR:d: 

 

/LANG:<code>
Force the program to start in a given language.    Supported language codes are GER for German and ENGL for 
English.
Example: MAILBELL /LANG:GER 

/MIN
Start the program with the window minimized. 

/STARTUPDELAY:<sec>
Waits the given number of seconds before starting the program. 

 
Alternately, you can specify command line options in Unix style, eg. 
MAILBELL -min -lang ger 
Instead of specifing the parameters on the command line you can also put them (one per line, backslash must be 
entered twice) into a file called commandline.ini in the program directory, e.g.: 

/LANG:GER
/MIN
/WORKDIR:d:\\data



Configuration

Topics in this section: 

o Program options 

o Spam options 

o Creating and changing data items 

 



Program Options

The program's options are subdivided these topics: 

o Window 

o Message List 

o Network 

o Outgoing Mail 

o File Locations 

o Maintenance 

 The notification options are organized like this: 

o New Mail 

o Alert-Popup 

o Mail Types 

o Mail Program 

 



Options -- Window

Main Window

Start program automatically
If this option is enabled your computer will start MailBell when you log on. This option is similar to putting 
MailBell into the Startup group in the Start menu (actually, instead of the startup menu, the Windows 
registry is used for this feature). 

Start program minimized
If enabled, this option will hide the program in the taskbar when it is started. 

The [X] button in the main window minimizes the program
If this setting is enabled the [X] button in the title bar will minimize the MailBell window to the desktop 
instead of closing the program. 

Hide toolbar
This option hides the toolbar with the click buttons to save window space. 

 

Tray icon clicks ...
When the program is minimized it hides itself in a small symbol in the system tray.    This option configures what
will happen if you double click or single click that symbol. 

... write new mail
Start the mail program to write a new email. 

... display the last popup message
Redisplay the contents of the last popup window (in case you were away from your desk and want to see
if there was new mail without actually connecting to the account). 

... check accounts for new mail
Connect to all accounts that have the tray-icon mail check option set. 

... display available mail
Connect to all accounts that have the tray-icon mail check option set and display all available mail (max. 
10).    This will only differ from the 'check accounts for new mail' function above if you have 'List Mail 
Details' enabled but 'List All Available Mail' disabled in Alert-Popup Options&per; otherwise both 
functions will show the same window. 

 

 



Options -- Message List

Confirm manual deletion
This option controls if a confirmation message box is shown when you use the Apply Deletion function of the 
message list window or when marked messages are automatically deleted when switching accounts. 

Save manually deleted mail in trashcan
If this option is enabled, a copy of (manually) every deleted mail is saved in the trashcan. 

Perform delete marked when closing window or switching accounts
If mail is marked for deletion it can automatically be deleted when switching accounts or closing the main 
window. 

Hide toolbar
This option hides the toolbar with the click buttons to save window space. 

Supress the dialog when adding friends or spam-senders
If you do not need want to see the dialog when adding friend or spam-senders you can disable it with this 
option. 

 



Options -- Network

Permanent connection
This option tells MailBell that the mail server is always available via LAN or permanent internet connection. 

Dial-up entry
If you are connecting to the internet via dial-up networking, please select your dial-up entry here.    MailBell will 
automatically detect when you go online and will then start checking for new mail.    You can configure if you 
want to do mail checking when going only with any of your dial-up networking entries or just with a specific one.
Warning! You can configure MailBell to dial out when an account needs checking and no internet connection is
available.    However, if you configure your accounts to check email frequently (e.g. every minute) this will result
in a high phone bill due to many phone calls. 

Dial out only ...
If you have to pay for dial out connections you can limit automatic dialing to certain hours of the day.    Enter 
time here in 24 hour format separated by a colon, e.g. "08:00" for 8am or 19:30 for 7:30pm. 

Hotmail via Proxy
To access hotmail accounts, MailBell simulates a web-browser.    Some environments require web access to go
through a proxy server.    If you need so specify a proxy server, please do it in the form <server> or 
<server>:<port> or <user>:<passwort>@<server>:<port>. 

 



Options -- Outgoing Mail

Use given SMTP-Server
If you find one of your real emails in the trash can you can "reactivate" it by sending it to your own mailbox 
again.    To do this, it is necessary that you enter your mail server and email address here.    MailBell will then 
send the email to yourself via that server. 

Determine SMTP-Server
If this option is enabled, MailBell tries to determine the SMTP server based on the receiver's email address via 
DNS. This option requires Windows 2000, NT, XP or Internet Explorer 6.x or higher. 

 



Options -- File Locations

Filenames
The names and directories where the list of email addresses are stored. 

Folder for Data Files
MailBell will store its configuration files in the given location. You can use this button to explore the content of 
the configuration folder (e.g. to backup your files) or move it to another location on your hard drive. 

 



Options -- Maintenance

Delete entries from trash after ...
With this option you can enable automatic deletion of messages in the trashcan after a given number of days. 

Delete spam senders after ...
With this option you can enable automatic deletion of entries in the list of spam senders after a given number of
days. 

 



Options -- New Mail

The options in this section of the configuration apply only if you added an email checking item to MailBell (see Using 
the program/Common tasks). 

Play sound for new mail
A sound file to play when MailBell detects new mail.    Optionally you can configure MailBell to play again and 
again (e.g. if you're sometimes away from your computer).    You can stop playing the sound from the File menu
or by using any other program function (e.g. by opening your mail program from MailBell). 

Show popup window for new mail
If this option is checked, MailBell will show a small unobtrusive window for every incoming mail.    You can close
that window by clicking on it with the left mouse button and you can start your email program by clicking on it 
with the right mouse button. (see Alert-Popup). 

Indicate new mail by blinking system tray icon
This option controls if the MailBell icon in the taskbar should blink if new mail has come in.    To stop the blinking
simply move the mouse over the icon. 

 



Options -- Mail Program

The options in this section of the configuration apply only if you added an email checking item to MailBell (see Using 
the program/Common tasks). 

Email program
The email program setting allows you to specify a program that you are using to read email.    MailBell can 
automatically start this program when new mail arrives and, if you are providing some text from the email 
programs title bar (e.g. the word Outlook), MailBell will check if this window is already open to avoid starting 
multiple copies of the program when more than one mail arrives. 

Parameter to write new mail
Most email programs support command line parameters to go directly jump to the new email dialog when 
starting the program.    E.g. for Outlook and older versions of Outlook Express this is /c ipm.note, for current
versions of Outlook Express use /mailurl:mailto:.    For Netscape it is -compose. This parameter is 
added to the email program command line if you select "Write New Mail" from MailBell's File menu. 

Parameter for inbox
Here you can add a parameter that passed to the mail program when reading mail.    Outlook does not need 
this parameter, for Netscape -inbox. For other mail clients, please check their help files or contact their 
support. 

Window title ...
As mentioned above, MailBell can look if your email program is already open.    However, some email programs
use different window titles for different parts of the program.    If you need to look for different keywords (e.g. a 
Window that either contains the word Mail-O-Matic or the phrase Compose message, you can put vertical 
bars between them e.g. Mail-O-Matic|Compose message. 

 



Options -- Alert Popup

The alert popup is a small unobtrusive window that is used to notifiy the user when new mail arrives. 

Position
Location where on the screen the alert message should be shown. 

Colors/Font
Text and background attributes to use when displaying a message. 

Show window for ... seconds
This is the time in seconds for which the window will appear. If you set this value to zero it will stay on screen 
until you click it away or until a new mail arrives in which case the window will be replaced by the new one. 

Show new mail's details    ...
When new mail arrives you will see the number of mails in your mailbox and the number of new mails.    
Additionally you can choose to display the mail's From, To and Subject field in the popup window for up to five 
new mails. 

Format
The format in which the details are displayed.    You may use any text and the placeholders $from, $to, 
$subject $date, $time, $size, $spam, and $type, e.g. 
$from: $subject
or From $from about $subject
Note: The placeholders must be typed in lowercase. 

Show extra buttons ...
If this option is enabled, the popup window will show a list of buttons at the bottom.    These buttons allow you 
to open the mail program ("read" button), to delete the message from the server (if supported by the mail 
account and if only one message is shown in the popup window), to show the MailBell inbox message list for 
this server ("inbox" button, only if more than one message is listed in the popup window), to display the same 
popup window later (unless new mail arrives in the meantime) and to close the popup window. 

 



Optionen -- Email Types

Email types allow you to define specific notification options (e.g. different sounds) depending on an emails 
characteristics. 
See Edit Mail Type 



Options -- Edit Mail Type

If you want different notifications for different types of mail (e.g. for important mail or for mail from your buddies) you 
can create, modify and delete mail types here.
When checking a mail for being of a special type, MailBell will start at the top of the list and work its way down.    The 
first hit will determine the mail's type.

For every mail type item you can set the following properties: 

Name
The name of the mail type (e.g. to be displayed in the popup window). 

Keywords/Phrases
A list of words or phrases to look for.    MailBell will treat each line in the list as a phrase and will look for a (case
insensitive) match in the mail, e.g. if you enter 
MailBell
Feature
special offer
the program will find mails that contain "EmTec feature", "mailbell price" but not ones that contain "special 
price". 

... in message header
If this option is checked MailBell will look for the keywords in the from, to and subject field. 

... in message body
If this option is checked MailBell will look for the keywords in the first 20 lines of the message body.    (However,
the message body is only available when checking mail on POP3, IMAP4 or MAPI accounts). 

... more than XX spam points
When incoming mail has been analyzed, it is assigned a certain amount of spam points, indicating the 
probablility that it is spam.    With this option you can build mail types based on the spam level.    However, the 
feature to exclude messages above a certain spam level from notification (Tools menu, Spam-Settings), takes 
precedence. 

Show popup
The state of this option overrides the same setting in the regular options and determines if a popup window is 
shown or not.    This way you could for example have popups for normal messages and suppress them for 
spam mail. This function will only work if this is the only (new) message displayed in the popup window.    it will 
be ignored if MailBell finds and displays more than one new message. 

Special color
This feature will determine the color of the entry in the popup window if a new mail of this type arrives. 

Mail is indicated by sound
This feature will play the sound file specified if a new mail of this type arrives (see note below).    
If you want to suppress the sound for this type of mail, please select the silent.wav file here. 

 
Note: If message of multiple types arrive in a batch the type that is highest up in the list will determine the sound and 
popup color.    Also, if one message matches the criteria for multiple types, it will be considered being of the type that 
is highest up in the list. 



Spam Options

The program's options are subdivided into the following topics: 

o Spam Handling 

o Bad Senders 

o Bad Words 

o Suspicious Words 

o More Bad Characteristics 

o Good Senders 

o Good Words 

 



Bad Mail Options -- Spam Handling

In this dialog you configure what to do with mail that has had bad or suspicious characteristics. 

Ignore in Email Notification ...
This option excludes mail from notification, i.e. such mail will not be counted in the window or taskbar icon and 
no notification will be played or shown when it arrives.    

Mark for deletion ...
Messages will be marked for deletion in the account's message list window.    There you can check the list, 
correct an occasional false hit or missed spam and then click on 'Apply deletion'. 

Move to Spam-Trashcan ...
With this option, mail get deleted from the server, so you won't have to download it when you start your mail 
client.    However, a preview copy is stored in MailBell's internal trash folder (accessible from the Tools menu), 
which you should regularly check and finally delete the messages there after you checked that no good mail 
got accidentally deleted.

 



Bad Mail Options -- Bad Senders

This dialog is the counterpart of the Good Words settings.    It offers more evidence for detection of bad mail. 
Bad mail will be handled according to your settings in Options, Spam Handling 

Spam Senders
Like the list of friends, this is the name of a file that contains email addresses or parts (e.g. bigdeal@aol.com or
@spamsenders.net) and will be found if any entry is found anywhere in the from field.
As with the Bad Words, the mail will be considered bad unless it also contains criteria from one of the Good 
lists.

offer@bulkoffers.com;
deals; bigdeals; superdeals
@spam.com

 

 



Spam Options -- Bad Words

This dialog is the counterpart of the Good Words settings. It offers more evidence for detection of bad mail. 
Bad mail will be handled according to your settings in Options, Spam Handling 

Bad Words/Phrases
If one of the words or phrases here appear in a mail's subject or message text, the mail will be considered bad 
unless it also contains criteria from one of the Good lists.
The phrases can be entered one per line or more per line separated by semicolons. 

UNIVERSITY DIPLOMA; become a doctor
penis enlargement; penis enhancement
speeding ticket
driving license; drivers license

 

 



Bad Mail Options -- Bad Words

Suspicous words and phrases mostly appear in spam but sometimes also in good mail.
Bad mail will be handled according to your settings in Options, Spam Handling 

Suspicious Words/Phrases
If one of the words or phrases here appear in a mail's subject or message text, they will be counted and the 
mail will be treated as suspicious.    In Spam Handling you can select what should happen with suspicious mail.
The phrases can be entered one per line or more per line separated by semicolons. 

credit card
money back guarantee
order now
click here

 

 



Bad Mail Options -- More Bad Characteristics

System Spam Keywords
This is the filename for the file that contains MailBell's primary list of bad/suspicious words.    You can remove 
predefined words here.    If you want to add your own words, please use the Bad Words or Suspicous Words 
dialog instead, unless you want to achieve very specific results (the System Keywords file is a bit more flexible 
than the dialogs).    
However, the list may be overwritten (after a confirmation window) with an update of MailBell. 

Far Eastern Spam
If you receive spam from eastern countries you can here add the character sets from the mail's MIME header 
which indicate such senders.    It is also possible to enable automatic detection of such charsets (which usually 
appear as illegible characters in the mail body). 

 



Good Mail Options -- Good Senders

My Friends and Partners
Similar to the list of interests and products in Good Words, this is a list of email addresses (or parts of 
addresses).    If any of these is found anywhere in the From field of an email (that is anywhere in the real name 
or email address), the filter will not consider the mail as bad, no matter what other characteristics it may have.   

Please not the last line in the example below, which declares anybody at emtec.com innocent.    But please be 
also aware that if all your friends have hotmail.com accounts it may not be wise to declare everybody at 
hotmail.com your friend, because a lot of spam comes from the hotmail.com domain. 

joe@privatemail.com
jenny@hotmail.com
@emtec.com

 

Bad mail will be handled according to your settings in Options, Spam Handling 

 



Good Mail Options -- Good Words

This dialog page is intended to identify mail that is definitely not spam. Although, it is not strictly necessary to enter 
data here, the more complete you configure this part of the spam options, the more aggressivly you can configure the
spam handling (see Spam Handling. 
If you are a dealing with special products (e.g. if you are a software vendor) or if you are subscribed to mailing lists, it 
is highly recommended, that you enter keywords for your products and for your subscribed mailing lists. 

My Interests and Products
This is a list of words and phrases that will tell the spam filter, which a mail is to be considered innocent, if they 
appear in the mail's subject or body. Typically you list names of goods and products you sell and headers of 
mailing lists you are subscribed to.      
Words and phrases are not case sensitive.    More than one word or phrase can be entered per line, if they are 
separated by a semicolon.    
The sample below will protect mail regarding some EmTec products, mail from the EmTec announcement and 
ZOC product mailing lists and also probably mails with bad jokes (which may contain obscene words which are
normally characteristic for spam), if they contain the word "joke" somewhere. 

mailbell; atomsync; zoc
[emtec-announce]
[emtec-zoc]
joke

 

 



Creating and Changing Email Account Entries

For each of the email account entries you can configure the following sections: 

o General 

o Access 

 



General

This dialog is used to add another email account to MailBell. 

Label
This is a text to describe the mail account (it will appear in the window that will notify you of new mail).

Check mail every ...
This setting defines how often MailBell should check new mail. If you set this value to zero the item will not be 
refreshed at all (it will only refresh if you select "update now" from the program menu).

Check this account from the tray-icon
This option determines if this account is included in mail checks that were initiated by a click on MailBell's tray-
symbol (see Dialog Options). 

Double clicking this account starts a special mail-programm
If you use different email prgorams for different account, you can specify these here. 

Spam detection enabled
If this option is enabled, MailBell scans every incoming mail for spam. 

 
Important: Please be aware that regular email checking will cause line traffic which could keep your internet 
connection from being idle-disconnected (unless you use a smart tool like EmTec's Yonc, which allows idle-
disconnects even if there is some line traffic). 



Access

MAIL TYPE

POP3/IMAP4 mail account
MailBell allows you to check POP (post office protocol) mail accounts for mail.    To do this you need to enter 
the provider's mail server, your account name (which is normally different from your email address) and your 
mail password here.
Naturally these settings vary from provider to provider, but in many cases they will be similar to the following 
example:
If your email address is joedoe@provider.net the mail server will probably be mail.provider.net and it
is likely that your account name will be joedoe.    And, many times the password is the same that you use to 
login to the internet.
If you are not sure about these settings, please check the documentation that you received when you 
subscribed with your provider, or simply call their support staff.

MAPI direct access
MailBell can check mail on any type of mail server (e.g. Microsoft Exchange Server) if the server is accessible 
via Microsoft MAPI. This is useful if you are accessing mail through a MAPI mail program (e.g. Microsoft 
Outlook) rather than through an internet Mail program (like Outlook Express or Eudora).
If you select MAPI as your mail server type, MailBell does not require any additional information to access mail 
on the server because it uses the mail account information that is configured under Control-Panel->Mail.

Note: Please be aware that system errors may occur if MAPI is not configured correctly or if the mail server is 
not available or restarted.

Important: MAPI direct access only works, if you have a permanent connection (e.g. via LAN) to your mail 
server (see Options->Network).

Web-Based mail account (Hotmail)
If you are using web based email on one of the supported servers, simply select the web host and enter the 
username and password that you are using to login on this host.

Alternate inbox folder
For IMAP accounts you can run the mail check on a different folder (by default the folder named "INBOX" is 
used). 

Download Mail Texts
For POP3, IMAP, MAPI and Hotmail mail accounts MailBell can download the first lines of the message text.    
The message text can be used to determine mail types (File, Options), Spam or it can be shown via the Show 
Message List function from the menu 
You can control how much text of an email is downloaded here.    While smaller values are preferable in terms 
of performance, the drawback is that MailBell has less text to analyze.    Important: Also, if a message is larger
than the size you set here, reactivation (from the Trash window) will only recover the part which was 
downloaded, so larger values are preferable when it comes to full recovery of accidentally deleted items. 

 



Advanced

 



Message list (Inbox)

The message list window shows a list of all messages in your inbox and allows you to delete messages without 
downloading them or to quick view the first few lines of the message (e.g. to determine if you really want to delete 
them.)
You can choose functions either from the Message menu in the program's menu bar, from the toolbar, or by right-
clicking a message.
 
Message Deletion
When you select the delete function the message is marked for deletion and will actually be deleted after you 
confirmed the delete operation when choosing Apply Deletion or when switching to another account's message list.    
Depending on your spam options, messages can be already marked for deletion when you open the list.
 
Message Texts
If your mail account supports text downloading and if text downloading is enabled in your account profile (Account, 
Edit) you can also view the message text without actually downloading it to your Mail program.    Please be aware that
this is only a quick view function, i.e. the message will remain on the server and can still be accessed via your regular
mail program. Also, the message will only be displayed in plain text, so the appearance may be quite different from 
the actual mail program
 
Spam
If the account contains mail, that earned itself evidence points, you can show a spam log file for the message, to see 
why a message is suspected of spam (or why it isn't).    Looking at the spam log will give you clues that can help you 
to fine tune the spam detection. 

Friends/Spam Senders
MailBell maintains lists of email addresses to determine mail from friends and from spam senders.    If you receive 
mail from either, you can add them to these lists, from the Message menu (however, you should only do this for spam
senders, that are not otherwise detected and who send spam more than once).

Sorting
You can sort the message list by clicking on the column headers. 



Configuration Wizard



Configuration Wizard - Network

Permanent connection
This option tells MailBell that the mail server is always available via LAN or permanent internet connection. 

Dial-up entry
If you are connecting to the internet via dial-up networking, please select your dial-up entry here.    MailBell will 
automatically detect when you go online and will then start checking for new mail. 

 



Configuration Wizard - Account Setup

The account setup is necessary to tell MailBell where to get your email from.    This process is a bit technical, but 
nontheless necessary.    
Depending on the type of email account you have, please read the corresponding instructions below (many users will 
have POP3/IMAP or web-based Hotmail accounts).    
If you have multiple accounts, you will be able to add these in the program directly (after the configuration wizard was
completed). 
You will need an internet connection before you use the Test buttons. If you have a dial up networking connection, 
please connect to the internet via dial up networking or web browser before clicking the buttons. 

Web-Based Email
SpamDetectie currently only supports native Hotmail accounts (i.e. email addresses in the form 
xxxxx@hotmail.com). Other web based email accounts may also have POP3 or IMAP access (e.g. paid 
yahoo.com or gmx.de accounts).    Unfortunately @msn.com accounts are not supported. 

POP3/IMAP Accounts
Most email accounts are accessed through the so called POP3/IMAP interface.    The required data normally 
has already been entered into your email client and can be retrieved from there.    
Outlook Express 5.0 or higher: Select Tools, Accounts.    There you will see your email account.    Select 
Properties and then Servers.    There you will see the name of your incoming mail server, the mail server type 
and account name.    Use these in the corresponding fields of the configuration wizard. Please also note your 
outgoing mail server, because you will need to enter this in one of the next steps. 
Eudora Go to Tools, Options, Getting Started.
Other email programs will have similar dialogs from which to copy the data.    
Note: If you are not sure what to enter here, simply call your mail provider's hotline.    The support staff will be 
able to give you the necessary information. 

AOL Email
AOL uses a proprietary email system and does not allow 3rd party software to access email on @aol.com 
accounts.    Hence AOL email accounts can not be used with MailBell.    However, you can access other email 
provider's accounts while being logged in to AOL. 

MAPI (MS Exchange, Lotus Notes, etc.)
MailBell can access email through the MAPI interface.    However, only the default MAPI account is checked.    
MailBell can not access alternate MAPI mail profiles. 

 



Configuration Wizard - Own Email

To decide if the incoming mail is addressed to you, MailBell need to know about you email-addresses and your 
usernames. 



Configuration Wizard - SMTP

If you find one of your real emails in the trash can you can "reactivate" it by sending it to your own mailbox again.    To
do this, it is necessary that you enter your mail server and email address here.    MailBell will then send the email to 
yourself via that server. 



Other Topics

o Tips/Questions/Problem 

o Ordering MailBell 

o Reporting Ideas, Problems and Bugs 

o About MailBell 

 



Tips/Questions/Problems

Where do I add or change mail accounts?
Just bring up the main window (e.g. by choosing 'Show Main Window' from the system tray icon's right mouse 
button menu).    In the main window you can add, modify and delete entries. 

How can I have different sounds/colors for different mail accounts
Edit the account and select a text and background color for the account. 
Alternately go to Options->Mail-Types and create a mail type for each account. Put your email address in the 
keywords field and enable search in the mail header.    Then select a sound file and/or color for this type.    
Move the type down in the list so that it won't override your sound/color settings for important email. 

Where can I get updates?
Please fire up your web browser and go to http://www.emtec.com 

How do I order?
Please checkout the Order Form in the Help menu and/or check Ordering MailBell topic in this help file. 

How can I start MailBell minimized?
Edit the properties shortcut which you are using to start MailBell and add /min to the command line, e.g. 
c:files.exe /min. Or simply activate the Start-Minimized option in MailBell's dialog options. 

I want to backup my data files
Please go to Tools, Working Directory, Explore Folder's content.    The files there are your MailBell configuration
(all these files are plain text.) 

I think I found a bug
See Support and Bug-Reports. 

How can I uninstall MailBell?
Please open the Windows Control-Panel and double click 'Add/Remove Programs'. Then select MailBell and 
click on 'Add/Remove'. 

 



Ordering MailBell

If you want to order MailBell, please select the Order-Form item from the Help menu or start the separate Order 
application from the MailBell program group.    There you will find all necesary information regarding pricing and 
payment.

When ordering MailBell, you will receive a license code which turns off the evaluation mode of your installed copy of 
MailBell.    This license code will work for the current version of MailBell and for all versions with the same major 
version number (e.g. all 1.xx versions).    The idea behind this license scheme is to provide users with free bug fixes 
and minor improvements (like additional configurability and improved user interface). However, at some point, EmTec 
will probably make a new release with major improvements and a new major version number.    In this case registered
users will be offered upgrades at a reduced price.

When ordering you can choose from the following options: 

MailBell License
A code to license the program for one machine/user (see important note below). 

Diskette
A 3.5'' disk with the latest MailBell version available. 

 
Important: MailBell's Web-Email feature is based on the layout and inner workings of the Web-Sites that provide web
based email.    Due to the nature of this feature, mail checking on web sites may become unavailable if the provider of
the web site changes the layout or mechanism to access the email.    EmTec will try to provide MailBell updates to 
keep this feature working when a web email site changes.    But please be aware that we can not guarantee that we 
will be able to do so in some or all cases! 
Please see also Author-Contact and How to get support/report bugs. 



Reporting Ideas, Problems and Bugs

If you have questions about ordering/paying the program, please go to Ordering MailBell.

Of course there are no bugs in this program but you probably know the saying "It's not a bug, it's a feature", so here 
is how you ask questions, how to tell us about your ideas or how to report "undesired features" (sorry, we could not 
resist the joking here, but we will take your reports seriously).
First of all, please check out the help text related to your problem (e.g. for a certain option) and also browse through 
Common Questions, to see if the problem is known and if an answer is already provided there.
If this does not help, please contact us via email and provide a description of the problem.    To solve a problem it is 
important for us to be able to reproduce it or at least to get as many details as possible. So please try if the undesired
feature or problem occurs only in specific situations or if is related to specific program settings (e.g. an problem might 
only occur the first time after the program was started, or only if a certain option is enabled or only while there is a 
lunar eclipse).
Generally, it will help us if you try various things to find out what exactly is going wrong and provide as many details 
as possible. 

Please send your report (or suggestions) through the Support link on our website http://www.emtec.com 
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